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Initial Info



macOS Meta Keys



; Command å Tab ' Space

' Option or Alt fn Function ³ Right

# Control + Delete ± Left

ç Shift © Return ± Up

« Escape ' Enter (fn+©) ³ Down



macOS 
Disclosure Buttons



Always click on disclosure buttons in dialogs







To open all disclosure boxes by default, open Terminal, 
enter the following on one line, & press ©: 

defaults write -g 
NSNavPanelExpandedStateForSaveMode -bool true

Then do the same thing with this: 

defaults write NSGlobalDomain 
NSNavPanelExpandedStateForSaveMode2 -bool true



Starting with macOS 13 Ventura (2022), disclosure 
buttons are no longer present in many locations where 
they formerly were





Same thing for printing dialog boxes







To open Show Details by default, open Terminal, enter 
the following on one line, & press ©: 

defaults write NSGlobalDomain 
PMPrintingExpandedStateForPrint -bool true



Starting with macOS 13 Ventura (2022), you no longer 
need to worry about expanding the printer dialog box







Mac Trackpads



Mac users, for some reason Apple turns on by default a 
setting that makes it very diûcult to use trackpads to 
drag windows, files, & content 

It’s horrible! Let’s fix it!



ÿ > System 
Preferences > 
Trackpad > 
Point & Click 

Un-7 Force 
Click and haptic 
feedback 

Aaahh… 

Now click ï



In macOS 13 
Ventura, it’s ÿ > 
System Settings 
> Trackpad > 
Point & Click 

Un-7 Force 
Click and haptic 
feedback
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/ is a slash (or forward slash) used by every 
operating system in the world (e.g., macOS, Linux, 
UNIX, but not Windows) to denote ûle paths 

» /Users/dbowie/Documents 
» Web Dev Projects/colors/index.html 

\ is a backslash used by Windows to denote file paths 

» C:\Users\dbowie\Documents 
» Web Dev Projects\colors\index.html



Sometimes macOS, Linux, UNIX, & Windows use the \ 
to escape a character 

Escaping a character tells the operating system or 
program to treat the following character in a special way 

For example, \n means “this is a newline, a line break 
created by ©” & not the letter n 

If you see a \ followed by a character, unless it’s a 
Windows path, it’s probably an escape



Webpage URLs only use the / 

https://www.granneman.com/teaching/web-
development-granneman-way
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Unzipping



You zip a folder or files for 2 reasons: 

» Archiving: join several files together into 1 file 
» Compression: join several files together into 1 file that 

is smaller than the individual files



Would you want to email 
someone 16 diûerent files?  

Would they want to receive 
16 attachments to your 
email?



On a Mac, select all the 
files, right-click, & select 
Compress (zip) 

Windows is diûerent 
(more on that in a minute)



Send Archive.zip to 
someone 

When they unzip it, now 
they have all 16 files



These files add up to 34.53 
MB



Archive.zip is 33.7 MB, 
not much smaller than 
34.53 MB 

Why isn’t it smaller?  

Because JPEGs & EPUBs 
are already pretty 
compressed



This is a zip file full of 
Word files ending in .doc



Unzipping a 389 KB file 
results in an original folder 
that was 1.8 MB 

The zip file is ~88% 
smaller! 

Why? Because .doc files 
aren’t compressed by 
default (.docx files are 
compressed, however)



ÿ 

After downloading a ZIP file (e.g., foo-bar.zip), just 
double-click on the file & you will have a folder named 
foo-bar next to the ZIP file 

Done! � 

Throw away the ZIP file if you want



What about zipping up a folder or files? 

Right-click (or #-click) & select Compress



¾ 

After downloading a ZIP file (e.g., foo-bar.zip), do not 
double-click on the ZIP file! 

Instead, right-click on the ZIP file & select Extract All& 

A folder named foo-bar should appear 

Throw away the ZIP file if you want

�







Stupid Windows — why create a 

folder inside a folder? �



�



What about zipping up a folder or files? 

Right-click on the folder or file & select Send to > 
Compressed (zipped) folder





& now you can rename it



¾ 

If you do not see Extract All&, you have a 3rd-party 
unzipping program installed 

Look for something else



¾ 

And by the way, if you really want a 3rd-party tool… 

1. uninstall yours (if you aren’t using the built-in tool) 
2. go to www.7-zip.org 
3. download 7-Zip & install it

https://www.7-zip.org


Searching



macOS



On a Mac, press ;' to invoke 
Spotlight, the built-in searching tool



Type the name of an app in Spotlight, use 
���� to move around, & press Enter or click 
on the app when you see it



You can also search for files … 
& many other things as well



Windows



Windows 10 Search box



Click inside of search 
box to activate, or 
press ¾Win+Q



Type your search 
term 

Use ���� to 
move around in the 
Start menu 

Press Enter to open 
the app or file



Windows 11 does something weird & kinda dumb

Start Search



If you ¯ click on Start & then  
° click in the Search box at the top…

¯

°



…Start closes & the Search menu opens, which is confusing 
& weird, so you might as well just click on Search



Type your search 
term 

Use filters 

Use ���� to 
move around in the 
Search menu 

Press Enter to open 
the app or file



Show File Extensions



We need to make sure that extensions (e.g., .html, 
.zip, .jpeg) show up at the ends of filenames



4 diûerent kinds of image)—)
png, gif, jpg, webp)—)but 
which is which?



CSS, HTML, & image)
—)extensions would 
be easier & faster



Extensions are oû 

Oooh! A sexy picture!



Extensions are on 

Aaagh! It installs a virus!



ÿ 

Click on the Finder 

Click on Finder > Preferences 

Click on the Advanced button 

Check the box next to Show 
All Filename Extensions 

Close the Preferences window



Windows 10

¯

°



Windows 11

¯

°



¾ 

Refer to Configuring Windows To Show Extensions at 
www.granneman.com/tech/windows/showextensions/ 
& follow those directions

https://www.granneman.com/tech/windows/showextensions/


/ SIDE NOTE

For a video about this process, see Visual Studio Code - 
Initial Info - Turn on Filename Extensions at 
vimeo.com/761686499



Main Project Folder



What’s the meaning 

of life? And where should 

my Web projects files go?

Photo by Grag Rakozy on Unsplash



We need a place to store all your project work 

Go to your Documents folder 

Create a new folder named exactly Web Dev Projects





㈂



If you are not using your own computer, go to a cloud 
drive (e.g., Dropbox, iCloud Drive, One Drive, Box, or 
Google Drive) 

Create a new folder named exactly Web Dev Projects 
inside a Documents folder (create the Documents folder 
if it doesn’t already exist)





Sometimes cloud drives 
like to move some or all of 
your files in them oû your 
computer & into the Cloud 

Result? Your pages don’t 
work because key files are 
no longer on your 
computer 

Fix: re-download all files



/ SIDE NOTE

For a video about this process, see Visual Studio Code - 
Initial Info - Main Project Folder at vimeo.com/
758991172



Why VS 
Code?



I’ve always been looking for an editor that met all 3 
conditions)—)with VS Code, I found it

Free

Cross-platform 

ÿ¾�ò

Powerful



Visual Studio Code is a powerful source code editor 

» Debugging 
» Embedded Git control 
» Syntax highlighting 
» Intelligent code completion 
» Snippets 
» Code refactoring 
» Highly customizable theme, keyboard shortcuts, & 

preferences 
» Updated every month!



Installation





VS Code is available for download at 
code.visualstudio.com

https://code.visualstudio.com


/ SIDE NOTE

Microsoft also makes a developers’ tool named Visual 
Studio for those who code in .NET & C++ (& many 
other languages) that dates back to 1997 

Visual Studio b Visual Studio Code 

Yes, this is confusing 

Make sure you are using Visual Studio Code!



Click this



ÿ



A file named something like VSCode-darwin-
stable.zip will appear in Downloads 

Double-click on the ZIP file & a few moments later you 
will see Visual Studio Code.app



Drag VS Code into the Applications folder



Toss the ZIP file into the Trash (or just select the file & 
press ;+)



c



A file named something like VSCodeSetup-
x64-1.24.0.exe will download 

Double-click on the EXE installer



If you’re asked if you want to “allow the following 
program to install software on this computer”, click Yes 

Click Next 

Accept the agreement 

Click on Next until you click on Install 

Click Finish



Toss the EXE installer into the Recycle Bin





A file named something like code_1.38.0-1567547996_
amd64.deb will download 

Debian/Ubuntu: sudo apt install ./<file>.deb

Installing the .deb package automatically installs the 
APT repository & signing key to enable auto-updating 
using your system’s package manager



Snap: sudo snap install --classic code 

RHEL, Fedora, & CentOS: sudo dnf install code or 
sudo yum install code 

openSUSE & SLE-based: sudo zypper install code 

Arch: makepkg -si visual-studio-code-bin 

Nix: nix-env -i vscode





You can also run VS Code in a Web browser in 3 ways 

» Directly in a GitHub repo 
» At vscode.dev 
» Codespaces





1. Open a GitHub repo in your browser 
2. Press . (a period) 
3. Whoa!







Completely free to every GitHub user!



vscode.dev





vscode.dev, using the default dark theme



None of my extensions are here



Click to open the Manage menu





I used GitHub





Immediately it switches to theme I’m using on my Mac



Extensions that will work on the Web show up now



Let’s check Settings…



& there all of mine are!







Try very hard not to open single files)—)VS Code 
wants you to work on projects/folders











“The Visual Studio Code Server is a service you can run on 
a remote development machine, like your desktop PC or 
a virtual machine (VM). It allows vou to securely connect 
to that remote machine from anywhere through a 
vscode.dev URL, without the requirement of SSH.”





Sign in to GitHub…









“Your changes will be committed and immediately pushed 
to the ‘main’ branch on GitHub.”



vscode.dev is completely free



Codespaces













“Codespaces is available for free for individual use for 
up to 60 hours a month and comes with simple, pay-
as-you-go pricing afterwards.”









You should have VS Code installed)—)now open it



GrannePacks



VS Code does a lot out-of-the-box, but you can add on 
almost any feature you can think of via extensions



Go to the Extensions View of VS 
Code by clicking on the 5th icon 
down (     ) on the Activity Bar on 
the left side of VS Code 

You could also: 

» View > Extensions 
» Press ç;X/Ctrl+Shift+X



You can install extensions one at a time, or you can 
install an extension pack that installs several at once



Install these 3 extensions



Using 
VS Code



Let’s take a tour of VS Code



The User Interface





Editor



Breadcrumb



Breadcrumb



Breadcrumb



Breadcrumb



Minimap



Activity Bar



Activity Bar buttons change the view 
in the Primary Side Bar, here showing 
Explorer View



Search button on the Activity Bar 
switches to the Search View, for search 
& replace in all files in a project



This 
searches 
every 
page in 
the 
project

This searches this page 
only (;F/Ctrl+F to Find; 
';F/Ctrl+H to Find & 
Replace)



Extensions button on the Activity Bar 
switches to the Extensions View, so 
you can add new features to VS Code



Name of current project



All files & folders in current project (folder)



The same project using my file manager, with the 
same files & folders  

(ignore .vscode from the previous slide; it’s here, but it’s hidden)



Project in 
VS Code Same files in a folder 

in my file manager



Currently open editors (files)





Tabs



Live Preview 
(requires 
extension)



Split Editor



More Actions



Status Bar



Panels 
1. Terminal 
2. Problems 
3. Output 
4. Debug



To open Problems, press  
ç;M/Ctrl+Shift+M …

… or click here



To open Problems, press  
ç;M/Ctrl+Shift+M …

… or click here



Integrated Terminal



Settings



Now we need to edit VS Code’s settings 

ÿ: Code > Preferences > Settings (or just press ;,) 

¾: File > Preferences > Settings



Let’s close 
the Sidebar…



Open Settings (JSON)





VS Code stores settings in settings.json 

JSON: JavaScript Object Notation 

Open standard file format 

Stores data in key:value pairs & arrays



/ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}



/ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}



/ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

"Key": Value 
(Boolean or #)

"Key": "Value" 
(String)

"Key": [Array]



/ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Comments not allowed 
in JSON, but are in 
settings.json 
(thanks, Microsoft!)



/ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Commas after every key:value pair…

…except the last one



/ SIDE NOTE

{
  "autoprefixer.formatOnSave": true,
  "colorHelper.formatsOrder": [
    "hsl",
    "hex",
    "named"
  ],
  "editor.fontSize": 16,
  // Enable for my own projects
  "editor.formatOnSave": false,
  "editor.wordWrap": "wordWrapColumn",
  "workbench.colorTheme": "Seti Monokai"
}

Commas after every value in an array…

…except the last one



Let’s replace the default settings with some I’ve created 

Go to https://chnsa.ws/1c7 

Click the Raw button 

On the following page, press ;A/Ctrl+A to select all of 
the code 

Press ;C/Ctrl+C to copy the snippet code (everything 
from)—)& including!)—)the first { to the last })

http://chnsa.ws/1c7


Go back to VS Code & click in User Settings on the right 

Select all of the content in your settings by pressing ;A/Ctrl+A 

Paste the settings you copied with ;V/Ctrl+V, overwriting 
what was there 

Save what you just pasted in by pressing ;S/Ctrl+S (if the font 
gets bigger, it worked) 

Close User Settings by clicking the × on its tab or by pressing 
;W/Ctrl+W



Key Features



Command Palette



;çP/Ctrl+Shift+P opens the Command Palette so you 
can run editor commands that aûect your code 

You will use this a lot, so get used to it



All editor commands

;çP/Ctrl+Shift+P



Filter commands

;çP/Ctrl+Shift+P



Most recent editor commands at top

;çP/Ctrl+Shift+P



IntelliSense



IntelliSense combines several features 

We care about code completion & quick info



Code completion 

As you type, IntelliSense lists suggestions in a small pop 
up 

Suggestions depend on the language you’re working in  

If you continue typing, the list filters to include only 
items containing your typed characters 

Press Tab or Enter to insert the selected list item







 Now type a > to complete the tag 





Let’s hit ©/Enter to properly format…





If only there was a way 

to automate that… �



If you don’t see the code completion pop up, press #'/
Ctrl+Space



Quick info 

Very short documentation explaining the purpose of… 

» an HTML element 
» a CSS property or value 
» a JavaScript method & parameter info 
» a Sass variable 
» & much more!













By default, you won’t see quick info 

Here’s how to enable it…



Type <p & hover over 
the far right of the blue 
bar until you see >



Click on the > & quick info appears 

You only have to do this once per language



If you don’t see the quick info pop up, press #'/
Ctrl+Space



Emmet



Emmet (formerly Zen Coding) is a set of plug-ins for 
text editors that make it very fast to code & edit HTML, 
CSS, XML, & other structured code formats 

Started in 2008 & still going strong 

Some editors (like VS Code) come with Emmet built-in 

� � �



You type p*3 & Emmet outputs: 

<p>
  |
</p>
<p>

</p>
<p>

</p>





What I typed



Code completion/Emmet



Quick info



You type ul>li*3 & Emmet outputs: 

<ul>
  <li>|</li>
  <li></li>
  <li></li>
</ul>





You type p+ul>li*3 & Emmet outputs: 

<p>
  |
</p>
<ul>
  <li></li>
  <li></li>
  <li></li>
</ul>





You type div.container>div.row>article>
h2{Article Title}^aside>h2{Aside Title}

+p*2>lorem & Emmet outputs… well, just take a look







div.container
>div.row
>article
>h2{Article Title}
^aside
>h2{Aside Title}
+p*2>lorem

<div class="container">
  <div class="row">
    <article>
      <h2>Article Title</h2>
    </article>
    <aside>
      <h2>Aside Title</h2>
      <p>
        Lorem ipsum…
      </p>
      <p>
        Consequatur, tempore? …
      </p>
    </aside>
  </div>
</div>



VS Code enables Emmet expansions by default in 
HTML, Haml, Jade, Slim, JSX, XML, XSL, CSS, SCSS, 
SASS, LESS & Stylus files)—)& any language that 
inherits from any of those, like Handlebars & PHP



Emmet does a lot more than expanding abbreviations 

Matches opening & closing tags • Select all content 
inside tags • Wrap selected content inside tags • Control 
insertion point placement after expansion • Easily jump 
to the next edit point • Toggle comments • Remove tags 
• Merge lines)—)without selections! • Automatically 
insert image height & width • Evaluate math 
expressions • Increment & decrement numbers • Copy 
CSS values to vendor-prefixed properties



To perform almost all of those actions, you use the 
Command Palette or come up with keyboard shortcuts 
(more on those later)





For much more on Emmet, see my presentation 
Emmet: Automate Your HTML & CSS 



Snippets



Remember how VS Code formats the <p> tags by 
default when I type them?



 Now type a > to complete the tag 





I don’t want <p>|</p> 

I want 
<p>
  |
</p> 

Snippets in VS Code allow me to do that because they 
let you define small patterns of code that expand when 
you type a trigger prefix



Simply type the start of a snippet, like p (you decide 
what the prefix will be) 

Code completion shows what will happen if you press 
Enter 

Quick info tells you what will happen if you press Enter



Let’s look at this in 
detail…



This icon 
means it’s 
from Emmet

This icon 
means it’s a 
snippet

Code preview



Perfect!



Insertion point’s 1st  
position

Press Tab to jump to 
2nd position







Note the 5 tab stops



You create diûerent snippets for diûerent languages 

ÿ: Code > Preferences > Configure User Snippets 

¾: File > Preferences > Configure User Snippets 

Select the language in the Command Palette 

A JSON-formatted file named [language].json opens





Remember when we installed this? 
It installed HTML-, CSS-, & SCSS-
related snippets I created











This is the built-in, bare bones Emmet snippet



This is the snippet I created





Sometimes Emmet’s & mine are similar





Keyboard Shortcuts



Many (most?) commands have a key command 
equivalent 

For example, invoke the Command Palette & search for 
Join Lines



Mac users see a 
key command: #J

Windows & Linux users 

don’t get a key command ?



However, VS Code includes the ability to set or change 
key commands for everything



ÿ: Code > Preferences > Keyboard Shortcuts 

¾: File > Preferences > Keyboard Shortcuts



In the search box at the top of Keyboard Shortcuts, 
enter join (you don’t need to press ©/Enter) 

Look for Join Lines 

ÿ users get ^J)—)let’s provide ¾ & � with Ctrl+J too















Now that you’ve changed the command, nothing appears











I suggest changing the following: 

editor.emmet.action.wrapWithAbbreviation 
;E ;R/Ctrl+E Ctrl+R

Why the ;E/Ctrl+E first? Because that way I know it’s 
going to be a keyboard shortcut for Emmet 

;E/Ctrl+E for Emmet, then ;R/Ctrl+R for Wrap



Emmet: Balance (outward)

;E ;±/Ctrl+E Ctrl+±

;E/Ctrl+E for Emmet, then ;�/Ctrl+� for outward 

Emmet: Balance (inward)

;E ;³/Ctrl+E Ctrl+³

;E/Ctrl+E for Emmet, then ;�/Ctrl+� for inward



Emmet: Update Image Size 
;E ;I/Ctrl+E Ctrl+I 

;E/Ctrl+E for Emmet, then ;I/Ctrl+I for Image Size



Extensions 
& Themes





marketplace.visualstudio.com



GrannePack HTML installs the following extensions: 

» Auto Close Tag 
» Code Spell Checker 
» Color Picker 
» File Templates Manager 
» File Utils 
» HTMLHint 

» indent-rainbow 
» Live Server 
» Placeholder Images 
» Project Templates 
» Projects+



Basics



File Templates Manager 

ý 
Ivan Zakharchanka



Templates make it easy & quick to create new HTML (& 
other) files



Go to the Extensions View & install File Templates 
Manager by Ivan Zakharchanka



These are the 2 templates we’re going to work with 

HTML5 template: https://chnsa.ws/1b1 

Bootstrap 5 CDN template: https://chnsa.ws/1yn

http://chnsa.ws/1b1
https://chnsa.ws/1yn


Let’s fix the HTML5 template first 

File Templates Manager includes a template for 
HTML5, but I don’t like it, so we’re going to replace it 
with a better one I made



Load this in your Web browser: https://chnsa.ws/1b1 
(that’s a one, followed by a b, followed by a one)

http://chnsa.ws/1b1




Click on the Raw button



Press ;A/Ctrl+A to select all the text



Press ;C/Ctrl+C to copy the selected text 

Press ;W/Ctrl+W to close the browser tab



Now open up Visual Studio Code





Click on the Templates View title bar



These are default templates that 
are included with File Templates 
Manager (I deleted some that I 
never use)



Hover over HTML.html & you’ll see buttons



To work with individual templates, hover over the 
template’s row

Rename

Edit

Clone

Delete



Click on the Edit button on the 
HTML.html row



This is the HTML in the default 
template 

It ain’t great, so we’ll replace it 
with the code that you copied a 
few minutes ago



Press ;A/Ctrl+A to select all the text



Press ;V/Ctrl+V to paste the selected text 

Press ;S/Ctrl+S to save the changes to HTML.html 

Press ;W/Ctrl+W to close the browser tab



Now let’s create the Bootstrap 5 CDN template



Load this in your Web browser: https://chnsa.ws/1yn 
(that’s a one, followed by a y, followed by a n)

https://chnsa.ws/1yn




Click on the Raw button



Press ;A/Ctrl+A to select all the text



Press ;C/Ctrl+C to copy the selected text 

Press ;W/Ctrl+W to close the browser tab



Now go back to Visual Studio Code



Hover over the Templates View title bar  
& you’ll see buttons



To create a new template, hover over the Templates 
View title bar

Create

Refresh



Click on the Create button



You will be asked for the title of 
your template 

Type this exactly: 
Bootstrap 5 CDN.html



It should look like this 

Now press ©/Enter to create the new 
empty template



Press ;V/Ctrl+V to paste the new code you just copied 

Press ;S/Ctrl+S to save the changes to Bootstrap 5 CDN.html



Hey, you made a new template! � 

Press ;W/Ctrl+W to close the browser tab 

Click on the Templates View title bar to close Templates



You’ll never need to open Templates 
again unless you are creating, 
editing, or deleting a template



/ SIDE NOTE

You probably won’t need these, but in case you do… 

Bootstrap 3 CDN template: https://chnsa.ws/1b2 

Bootstrap 4 CDN template: https://chnsa.ws/1b3

http://chnsa.ws/1b2
http://chnsa.ws/1b3


/ SIDE NOTE

FYI where templates are stored (in case you want to 
back them up) 

ÿ: ~/Library/Application Support/Code/User/
CodeTemplates/ 

¾: %HOME%\AppData\Roaming\Code\User\
CodeTemplates\



Now that File Templates Manager is installed, here’s 
how to use it



There are 2 ways to invoke File Templates Manager 

1. Using the Command Palette 
2. Right-clicking in the Explorer View where you see all 

the files & folders in your current project/folder



Method 1: Using the Command Palette



Invoke the Command Palette (;çP or Ctrl+Shift+P)



Type until you see New File From Template… appear 
& press ©/Enter 

Now you would choose a template (coming up after 
looking at method 2)



Method 2: Right-clicking in the Explorer View



Right-click to bring up the context menu



Click on New File From Template&



No matter if you use method 1 or 2, 
the Command Palette now shows a 
list of templates (yours is probably 
longer because I removed several I 
don’t use) 

We want HTML.html



Type HTML until that template is selected & press ©/Enter,  
or use your � to select HTML.html & press ©/Enter,  
or just click on it



Type index, the name of the file you want to create,)
but do not type the extension, because that will be 
added for you, & then press ©/Enter…



Here’s your new file, 
ready to edit!

…& notice it’s using the HTML5 
template we copied into File 
Templates Manager



Remember, do not type the file extension (.html, .css,  
.js) when you are creating a new file from a template



Don’t do it! Just use index, not index.html!



Ruh-roh



Right-click on the file &… 
1. Delete the file & re-create 

2. OR Rename the file �





A very important tip about using File Templates 
Manager)—)whatever is selected in Explorer View will 
become the parent to any new file you create from a 
template 

In other words, pay attention to what is selected in 
Explorer View before you create a new file 

Let me explain with 3 examples…



Here’s how to create a new file in the root of your 
project



I want to create a new file at the root 
of my project, so that it is a sibling of 
css, index.html, & products 

Note that nothing is selected)—)to do 
that, I clicked in the empty areas 
under FOO 

See the blue border around the area 
under FOO? That means anything I 
create will be directly in the root)—)

perfect!



At this point, use method 1 (invoke the Command 
Palette directly with ;çP/Ctrl+Shift+P) or method 2 
(right-click) 

In these examples I’ll use method 2



Right-click to bring up the context 
menu 

(Notice where my pointer is)



Click on New File From Template&



The list of templates appears)—)we want HTML.html 

Type HTML until that template is selected & press ©/Enter, 
or use your � to select it & press ©/Enter,  
or just click on it



Enter the filename)—)in this case, foo)—)& 
press ©/Enter (Remember, do not add the  
.html)—)it will be put there for you)



And there’s our new file! Notice that is 
exactly where I wanted it: at the root 
of my project, as a sibling of css, 
index.html, & products 

(It is not inside css)—)see how it’s not 
indented like main.css is under css?)



Here’s how to create a new file inside another folder



I want to create a new file inside 
products named product-1.html 

Note that nothing is selected)—)I 
could click on products to select it 
first, but I don’t have to



Right-click on products to bring 
up the context menu 

(Notice where my pointer is)—)on 
products)



Click on New File From Template&



The list of templates appears)—)we want HTML.html 

Type HTML until that template is selected & press ©/Enter, 
or use your � to select it & press ©/Enter,  
or just click on it



Enter the filename)—)in this case, product-1)
—)& press ©/Enter (do not add the .html, 
since it’s automatically put there for you)



And there’s our new file, inside 

products like I wanted ���



Here’s how to create a new file inside the wrong folder



I want to create another new file inside 
products named product-2.html



I should right-click on the 
products folder, but I’m not paying 
attention & instead right-click on 
foo.html (right-clicking in the 
empty area inside FOO would cause 
the same problem you’re about to 
see)



Click on New File From Template&



The list of templates appears)—)we want HTML.html



Enter the filename)—)in this case, product-2)—)& 
press ©/Enter (no need to add the .html, right?)



And there’s our new file, but it is not 

inside products like I wanted �



So what if you do make a mistake in where you create a 
file? 

It’s an easy fix: drag ’n’ drop!



Select the file in the wrong location 
(in this case, product-2.html)



Now drag product-2.html on top of 
products, the folder it should be in, & 
take your finger oû your mouse (or 
trackpad) 

VS Code provides a nice blue back-
ground color to help you drag the file 
onto the correct target



When asked, click on Move



product-2.html is now where it 
should been if I had right-clicked 
on products in the first place



/ SIDE NOTE

For a video about File Templates Manager, see Visual 
Studio Code - Extensions - File Templates Manager at 
vimeo.com/758916351



Live Preview 

ý 
Microsoft



View your code live in a 
browser, as you work on it 

Make a change in the code, 
save it, & the webpage 
instantly updates in the 
browser



View your code live in a 
browser, as you work on it 

Make a change in the code, 
save it, & the webpage 
instantly updates in the 
browser



Basically, Live Preview starts a mini Web server on your 
computer  

That mini server lets you interact with your website just 
like a “real” one (e.g., Apache, Nginx, or IIS) would 
when you upload your site to the Web*

*Live Preview doesn’t do everything Apache, Nginx, or IIS does, which is why I called it a “mini” Web server



If you are on an HTML page, look up in the top right of 
VS Code’s window for this icon: 



Click on       to start the local server, which 
immediately… 

» opens the Terminal panel to run the Live Preview 
command line program (you can then close the panel 
if you want), and 

» opens the current HTML page in your default 
browser







To close the local server… 

» close the browser tab, or 
» press ^C/Ctrl+C in the terminal open in the Terminal 

panel



�PRO TIP

Leave the Live Preview running in your web browser! 

Do not close your web browser tab after looking at the 
webpage you’re working on! 

If the webpage is not updating when you save your 
code, then you can close the tab & click on the Live 
Preview button again



Projects+ 

ý 
Fabio Spampinato



Manage saved projects



You will now see a 6th icon on the Activity Bar:  

Click it to view your saved projects 

Click on a project to switch to that project





Group projects!

Current project



To add a new project, invoke the Command Palette & 
enter project save 

Give the project a meaningful name & press Enter 

Enter an optional description & press Enter 

Enter an optional group (e.g., if you want to group your 
projects by client or course) & press Enter 

Your project now appears in Projects



Project Manager 

ý 
Alessandro Fragnani



Manage saved projects



You will now see a 6th icon on the Activity Bar:  

Click it to view your saved projects 

Click on a project to switch to that project





Group projects!

Current project



To add a new project, invoke the Command Palette & 
enter project save 

Give the project a meaningful name & press Enter 

Enter an optional description & press Enter 

Enter an optional group (e.g., if you want to group your 
projects by client or course) & press Enter 

Your project now appears in Projects



HTMLHint 

ý 
Mike Kaufman

https://marketplace.visualstudio.com/publishers/mkaufman


Finds & reports problems in your HTML



Doesn’t do anything after you install it unless you set 
rules in settings.json 

My settings.json has these essential rules in it:  
DTD must be present • <html> must include lang • 
<title> required • Tags must be lowercase & paired • 
No self-closing tags; e.g., <br /> • Attributes must be 
lowercase & not duplicated • Values must use double 
quotes & no extra spaces • No inline styles • Cannot 
repeat id • alt required on images



Most of these came from HTMLHint



Colors



Color Picker 

ý 
anseki



Color Picker lets you generate colors using a GUI 

Supports named colors, hexadecimal, RGB/RGBA, & 
HSL/HSLA 

Click in a color & press 'C then P/Alt-C then P





indent-rainbow 

ý 
oderwat



indent-rainbow colorizes your indentation levels





Automation



Placeholder Images 

ý 
Jake Wilson



Easily insert placeholder images (temporary images 
while a design is still being finalized)



Supports the following services: 

» DummyImage.com 
» Fake Images Please 
» LoremFlickr 
» LoremPixel 
» Pipsum 
» placehold.it � Garbage)—)do not use 
» Placekitten 
» Placeskull 

» Unsplash {

http://DummyImage.com
http://placehold.it


Invoke the Command Palette, enter in Placeholder, & 
select Placeholder Images: Insert new image 

Select the service you wish to use 

Enter the appropriate information























GrannePack HTML installs the following themes: 

» Monokai Dark Soda 
» Material Icon Theme



Themes



Personalize the way VS Code looks with a color theme, 
which changes the colors of everything in VS Code





VS Code comes with several color themes pre-installed: 

Abyss • Dark+ (default dark) • Kimbie Dark • High 
Contrast • Light+ (default light) • Monokai Dimmed • 
Monokai • Quiet Light • Red • Solarized Dark • 
Solarized Light • Tomorrow Night Blue



I included Monokai Dark Soda in GrannePack HTML





You can pick your own 

Go to Extensions View & search for color theme 

Click on a theme that interests you 

You should see a screenshot on the right to help you 
decide if you want to check out the theme 

No screenshot? Forget it!





I suggest starting with these, as they are widely 
supported by almost all code editors: 

» Solarized (light or dark) 
» Soda (weirdly, there aren’t any light Soda themes, but 
Espresso Soda by Daur Gamisonia works) 

» Monokai (I like Monokai Dark Soda by Adam 
Caviness, as it combines the best of Monokai & Dark 
Soda) 

» Material 
» GitHub 
» Dracula



When you find a theme you like, click the green  Install  
button 

After it installs, click the blue Reload   button 

ÿ: Code > Preferences > Color Theme 
¾: File > Preferences > Color Theme 

The Command Palette will open showing all your themes 

Select the one you installed & press ©/Enter to enable it

 Install

 Reload 



A ûle icon theme puts little icons to the left of your files 
when you are in Explorer View





VS Code comes with 1 icon theme pre-installed: Seti 

I included Material Icon Theme in GrannePack HTML







You can pick your own 

Go to Extensions View & search for icon theme 

Click on a theme that interests you 

You should see a screenshot on the right to help you 
decide if you want to check out the theme 

No screenshot? Forget it!



I suggest starting with these: 

» Material Icon Theme by Philipp Kief � what I use 
» vscode-icons by Roberto Huertas 
» VSCode Great Icons by Emmanuel Béziat



When you find a theme you like, click the green  Install  
button 

After it installs, click the blue Reload   button 

ÿ: Code > Preferences > File Icon Theme 
¾: File > Preferences > File Icon Theme 

The Command Palette will open showing all your themes 

Select the one you installed & press ©/Enter to enable it

 Install

 Reload 



marketplace.visualstudio.com



GrannePack CSS installs the following extensions: 

» IntelliSense for CSS class names in HTML 
» Live Sass Compiler 
» npm 
» Style formatter



IntelliSense for CSS class names 

ý 
Zignd



Autocomplete CSS classes in your HTML as you type



Go to the Extensions View & install IntelliSense for CSS 
class names by Zignd



As you type class=", a list of class names will appear 
from your local CSS files & any remote ones you’ve 
linked to 

As you continue to type)—)e.g., class="le)—)the list will 
narrow down 

Select the correct match & press ©/Enter to 
autocomplete the class name









Narrow it down further…



Now press ©/Enter…





Live Sass Compiler 

ý 
Glenn Marks



Compile Sass into CSS manually or when you press 
Save 

More on this later!



Sass, before 
compiling into CSS



CSS, compiled 
from Sass



More 
Features



Debugging



VS Code helps you debug your code in 4 ways 

1. Syntax highlighting (colors) 
2. Warnings in the Status Bar & the Problems Panel 
3. Nesting via formatters 
4. Live Preview



Syntax Highlighting



Syntax highlighting colors your code based on the 
lexical categories of the language 

In HTML, you would see diûerent colors for tag names, 
attributes, values, & comments 

Diûerent languages are colored diûerently



Comments 
Tag names 
Attributes 
Values



Selectors 
Properties 
String values 
Functions 
Numeric values 
Units 
@rule 
Comments



�



�



�
�



�
�



Warning & the Problems Panel







Nesting via Formatters



If your code isn’t flowing correctly, something may be 
wrong



CSS



�



�



�



Live Preview



One of the most important 
tools for debugging



Code Folding



I want to collapse 
that <div> so I 
can see more code



Hover over the 
gutter & folding 
symbols appear



Click on the $ 
symbol & that 
section collapses!



Click > & it 
expands back



You can use key 
commands too! 



Fold (collapse) region at the cursor 

» Command Palette: search for Fold  
» ;'[/Ctrl-Shift-[ 

Unfold collapsed region at the cursor 

» Command Palette: search for Unfold  
» ;']/Ctrl-Shift-]



Nice, but what if I 
want to collapse 
everything?



Fold all regions (recursively) in your code: ;K ;0/Ctrl+K 

Ctrl+0 (zero) 

Place cursor on <html> & unfold, revealing a folded 
<head> & <body>: ;']/Ctrl+Shift+] 

Place cursor on <body> & unfold, showing all folded 
sections: ;']/Ctrl+Shift+] 

Now unfold (sections) recursively: ;K ;]/Ctrl+K Ctrl+]

Recursively fold section when finished: ;K ;[/Ctrl+K Ctrl+[



Rename Tags



You type <em>Unknown Kadath</em> & realize you 
should’ve used <i> instead 

Normally you’d have to manually change both <em> &  
</em> to <i> & </i> �



With Rename Tags, built in to VS Code… 

» change <em> to <i>, & it automatically changes </em> 
to </i>, OR 

» change </em> to </i>, & it automatically changes  
<em> to <i>



/ SIDE NOTE

I have enabled Rename Tags to run automatically in 
the Settings file I am providing you soon 

Without that automation, you’d have to run it 
manually by selecting the element & doing one of 
these: 

» Invoke the Command Palette (;çP/Ctrl-Shift-P) & 
search for On Type Rename Symbol 

» Press ç;F2/Shift+Ctrl+F2



Language Support



Built-in support for 

» CSS, Sass, & Less 
» HTML 
» JavaScript, JSON, & Node.js 
» Markdown 
» PHP 
» TypeScript



Extensions add support for other languages 

» C/C++ 
» C# 
» Go 
» Java 
» Python 
» Ruby 
» Rust 
» & many, many more



Git Integration



Git is the world’s most popular distributed version 
control system for tracking changes in source code files 
& coordinating work on those files among multiple 
people



VS Code has built-in support for Git











Thank you! 
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Bonus



Quick List of  
Installations & 
Configurations



These are the installations & configurations we perform 
throughout these slides 

I put them all here in 1 location as a reference



Install extensions 
;çP/Ctrl+Shift+P > Extensions: Install Extensions 
Search for GrannePack 
Install GrannePack HTML & GrannePack CSS



HTML snippets 
Preferences > Configure User Snippets > html.json 
https://chnsa.ws/16e 

CSS snippets 
Preferences > Configure User Snippets > css.json 
https://chnsa.ws/1bo  

SCSS snippets 
Preferences > User Snippets > scss.json 
https://chnsa.ws/1bx 

http://chnsa.ws/16e
http://chnsa.ws/1bo
http://chnsa.ws/1bx


VS Code settings 
;çP/Ctrl+Shift+P > Open Settings (JSON) 
https://chnsa.ws/1c7 

Keyboard Shortcuts 
Preferences > Keyboard Shortcuts 
Set editor.action.joinLines to 
#J/Ctrl+J

http://chnsa.ws/1c7


Set editor.emmet.action.wrapWithAbbreviation to 
;E ;R/Ctrl+E Ctrl+R

Set editor.emmet.action.balanceOut to 
;E ;�/Ctrl+E Ctrl+� 

Set editor.emmet.action.balanceIn to 
;E ;�/Ctrl+E Ctrl+� 

Set editor.emmet.action.updateImageSize to 
;E ;I/Ctrl+E Ctrl+I



File Templates Manager 
Replace HTML.html template with 
https://chnsa.ws/1b1  

New Bootstrap 4 CDN.html template using 
https://chnsa.ws/1b3 

New Bootstrap 5 CDN.html template using 
https://chnsa.ws/1wx

https://chnsa.ws/1b1
https://chnsa.ws/1b3
https://chnsa.ws/1wx


Set up Project Templates 

Select Color theme 

Select File Icon theme



Portable VS Code



Don’t have a laptop you can install VS Code on? 

You can install Visual Studio Code in Portable Mode, 
which runs on…  

» a USB flash drive 
» a portable hard drive 
» cloud storage (Dropbox, One Drive, Box, iCloud 

Drive, or Google Drive)



When you use VS Code in Portable Mode, all your 
extensions, settings, & other data reside in a folder 
along with the app 

You can therefore access & use VS Code from anywhere 
& have access to your setup without having to reinstall 
or reconfigure!



ÿ



A file named something like VSCode-darwin-
stable.zip will appear in Downloads 

Double-click on the ZIP file & a few moments later you 
will see Visual Studio Code.app



Drag VS Code into your Dropbox folder



Toss the ZIP file into the Trash (or just select the file & 
press ;')



Go to your Applications folder 

Double-click on VS Code to open it 

Once it is open, go ahead & close it



In your Applications folder, create a new folder named 
exactly code-portable-data 

Now when you run VS Code, all your extensions & data 
will live in the code-portable-data folder



Next time you automatically update VS Code, 
everything should just work



c



Click on 
Other platforms



Click on 64 bit zip 
(unless you have an 
ancient PC)



A file named something like VSCode-win32-
x64-1.26.1.zip will download 

Right-click on the ZIP file & select Extract Here 

You should now have a folder named something like 
VSCode-win32-x64-1.26.1

Drag that folder into your USB or cloud drive



Toss the ZIP into the Recycle Bin



Go into the VS Code folder (e.g., VSCode-win32-
x64-1.26.1) & its 60+ items (!) 

Note that to run the VS Code app, you need to click on 
Code.exe 

Create a folder named data in the same folder as 
Code.exe 

Now when you run VS Code, all your extensions & data 
will live in the data folder



Next time you update VS Code, follow the same 
procedure with the ZIP file 

However, drag the data folder from the old installation 
folder (e.g., VSCode-win32-x64-1.26.1) into the new 
installation folder (e.g., VSCode-win32-x64-1.27.1) 

Toss the old installation folder (e.g., VSCode-win32-
x64-1.26.1) into the Recycle Bin







A file named something like code-stable-
1567547931.tar.gz will download 

tar -xvzf code-stable-1567547931

You should now have a folder named something like 
VSCode-linux-x64

Drag that folder into your USB or cloud drive



Go into the VSCode-linux-x64 folder 

Note that to run the VS Code app, you need to run code 

Create a folder named data in the same folder as code 

Now when you run VS Code, all your extensions & data 
will live in the data folder



Next time you update VS Code, follow the same 
procedure with the TAR.GZ file 

However, drag the data folder from the old installation 
folder into the new installation folder 

Toss the old installation folder into the Recycle Bin



Command Palette



;P/Ctrl+P lets you navigate to any file in the project by 
typing its name



;P/Ctrl+P



^R/Ctrl+R opens a list of recently opened folders & files 
in the Command Palette



After pressing ^R/Ctrl+R



;çO/Ctrl+Shift+O lets you use the Command Palette to 
jump to a specific symbol in a file



;çO/Ctrl+Shift+O



;çO/Ctrl+Shift+O



;çO/Ctrl+Shift+O



;çO/Ctrl+Shift+O



;çO/Ctrl+Shift+O



? shows you a list of available commands for VS Code 
itself, not the editor





Snippets



/ SIDE NOTE

Only needed if you9re in my CSS course 

I’ve also already prepared scss.json for you to use 

� � �

32 lines as of September 11, 2019



/ SIDE NOTE

ÿ: Code > Preferences > User Snippets 

¾: File > Preferences > User Snippets 

Type scss & select it in the Command Palette 

A JSON-formatted file named scss.json opens



/ SIDE NOTE

Go to https://chnsa.ws/1bx 

Click the Raw button 

On the following page, press ;A/Ctrl+A to select all of 
the code 

Press ;C/Ctrl+C to copy the snippet code (everything 
from)—)& including!)—)the first { to the last })

http://chnsa.ws/1bx


/ SIDE NOTE

Go back to VS Code & click in scss.json 

Select all of the content in scss.json by pressing ;A/
Ctrl+A 

Paste the snippets you copied with ;V/Ctrl+V, overwriting 
what was there 

Save what you just pasted in by pressing ;S/Ctrl+S 

Close scss.json by clicking the × on its tab or by pressing 
;W/Ctrl+W



Extensions



Project Templates 

ý 
cantonios



Project Templates allows you to create entire projects 
from folders containing pre-made files & folders



Start by creating a 
folder & setting up 
the files & folders for 
a brand new project



Open Command Palette 
with ;çP/Ctrl+Shift+P & 
select Save Project as 
Template



Enter a name for your 
project template



You can now delete 
the folder you used to 
create your project 
template



Start with a new 
empty project folder



Open Command Palette 
with ;çP/Ctrl+Shift+P & 
select Create Project 
from Template



You’ll see a list of all 
your project templates



Click or type to filter 
the list



Congratulations)—)you 
have a new project!



File Utils 

ý 
Steûen Leistner



File Utils makes it easy to duplicate, move, rename, & 
delete files & folders



Right-click on a file or folder & select: 

» Duplicate 
» Move 
» Rename 
» Delete





Live Share Extension Pack 

ý 
Microsoft



Live Share Extension Pack installs 4 extensions: 

» Live Share: real-time collaboration on code 

» Live Share Audio: audio calls 

» Peacock: changes color of your workspace to 
distinguish collaboration workspace from others 

» Team Chat: messaging while collaborating (you can 
use Discord or Slack if you’d like)





Auto Close Tag 

ý 
Jun Han



VS Code has built-in support for auto-closing tags in 
HTML 

Type <p> & VS Code automatically creates </p> 

Auto Close Tag adds support for PHP, JavaScript, & 
other languages



CSS Extensions



Peeking



Want to quickly edit your CSS without leaving your 
HTML file? 

Peek! 

Put your insertion point inside the selector & do this: 

» Invoke the Command Palette (;çP/Ctrl+Shift+P) & 
search for Peek Definition 

» Press 'F12/Alt+F12



Press 'F12/Alt+F12



This is CSS 
from main.css

HTML



Edit & press ;S/Ctrl+S to update!



Changelog 

2023-01-23 1.24: Removed CSS extensions that are no 
longer part of GrannePack CSS; removed HTML & CSS 
snippets & added GrannePack Web Dev Snippets 

2022-11-27 1.23: Upgraded theme to Granneman 1.8; 
disclosure buttons & printing dialogs have changed in 
macOS 13 Venture; minor fixes & formatting after theme 
upgrade; hid details about creating Snippets; corrected 
many Windows shortcuts from, e.g., Ctrl-A to Ctrl+A; had to 
re-do every single Key Command character style!



Changelog 

2022-11-25 1.22: It’s now Configure User Snippets; added 
other key commands to Quick List of Installations & 
Conûgurations; changed Emmet’s Wrap with Abbreviation 
to ;E ;R/Ctrl+E Ctrl+R (R instead of W) because that 
conflicts with running VS Code in a Web browser 

2022-11-12 1.21: Added details re: typing file extension in 
File Templates Manager; added quite a bit in Installation 
on using VS Code in a browser via GitHub, vscode.dev, or 
Codespaces



Changelog 

2022-10-27 1.20: Added detailed, extensive instructions 
for using File Templates Manager; updated Main 
Project Folder; added more & clarified Live Preview; 
added Searching to Initial Info 

2022-07-25 1.19: Fixed order of Panels; updated 
screenshots of IntelliSense & Emmet



Changelog 

2022-07-20 1.18: Added screenshot of Finder 
Preferences for turning on extensions; added small 
section on Mac Trackpads in Initial Info; added section 
on Debugging in More Features; added screenshots 
showing how to show file extensions in Windows 10 & 
11; added small detail to Color Picker; added note re 
diûerences between Visual Studio Code & Visual 
Studio; minor edits



Changelog 

2022-04-05 1.17: Changed all uses of VSCode to VS 
Code since that’s how Microsoft refers to it at its 
website; brand new screenshots for User Interface, with 
a few new slides; added screenshots explaining how to 
add Ctrl+J for Join Lines; clarified Emmet key 
commands; added key command for Emmet: Update 
Image Size; made Folding much better with good advice



Changelog 

2022-03-29 1.16: Recommended 2 settings to change 
after importing settings.json; fixed incorrect 
comment about commas after array values; unhid slide 
in Code Completion that was the main point of the 
section!; updated number of lines in html.json & 
css.json; updated Live Preview with better details & a 
short video; fixed minor typos; got rid of Path 
Autocomplete since it’s now built in



Changelog 

2022-01-30 1.15: Added section explaining why zipping is used; 
moved Portable VSCode to Bonus; moved ;P/Ctrl-P & ^R/
Ctrl+R to Bonus under Command Palette; moved Command 
Palette screenshots out of Bonus & back to Command Palette; 
rearranged sections to make things flow better 

2021-12-13 1.14: Added graphical example for / & \; removed 
Live Server & added Live Preview; moved ;çO/Ctrl-Shift-O to 
Bonus section; removed slides on GrannePack Git & GrannePack 
Markdown; renamed Extensions section to Extensions & Themes 
& simplified layout; re-ordered Key Features section



Changelog 

2021-06-17 1.13: Mentioned Emmet presentation in the 
Emmet section; added new Quick List of Installations & 
Conûgurations under Bonus; fixed broken link 

2021-04-21 1.12: Removed old Emmet wrap command, as 
it’s no longer supported in VSCode; changed Git to Git 
Integration; reordered sections under Key Features; 
added Quick List of Installations & Conûgurations under 
Bonus; fixed all chnsa.ws URLs so they use HTTPS



Changelog 

2021-04-02 1.11: Changed Why VSCode? triangle; 
removed duplicate Auto Close Tag slide; changed theme 
to Granneman 1.7; fixed minor formatting errors; added 
detail to Peeking; changed The GUI to The User Interface; 
added screenshots to Project Templates; added slide 
listing contents of GrannePack HTML & GrannePack CSS; 
added sections on Bracket Pair Colorizer `, npm, & Style 
formatter 

2020-06-09 1.10: Minor fixes & updates



Changelog 

2020-04-11 1.9: Moved Conûguration much higher; 
changed Emmet keyboard shortcuts to fit with new 
scheme; added Why VSCode? section; removed Auto 
Rename Tag because the functionality is now built in to 
VS Code 1.44 as Synced Regions; added keyboard 
shortcut to open Problems panel; removed CSS Peek 
because peeking is now built in, so explained; added CSS-
Speciûc section & added content; added Bonus section; 
added open recently-opened folders to Command Palette



Changelog 

2019-09-14 1.8: Removed expand-region by Le Trieu 
because Emmet does it; removed Sort Lines by Daniel 
Imms because now built in; added extension screenshots 

2019-09-11 1.7: Added css.json & scss.json snippets; 
added installation instructions for Linux; updated all GUI 
screenshots; added GrannePack slides & did a little 
rearranging; added section on Emmet; split 
Conûguration into sections; little improvements 
everywhere



Changelog 

2018-11-29 1.6: Added section on macOS Disclosure 
Buttons in Initial Info; added screenshots for Windows 
zipping & unzipping; added slide re: zipping for macOS; 

2018-10-29 1.5: Minor formatting fixes; added slide re: 
Live Server port 5500; added hyperlinks to slide links; 
added DEMO! slide; cleaned up small stuû; added 
suggested keyboard shortcuts



Changelog 

2018-09-15 1.4: Switched out File Templates to File 
Templates Manager because the latter works on 
Windows; added details on unzipping 

2018-09-03 1.3: Took Your Username out of Initial Info 
& put it in with File Templates extension; Added / & \ to 
Initial Info; added instructions for using File Templates; 
added Side Note & Pro Tip to Live Server; labeled 
screenshots for HTMLHint & CSSTRee validator



Changelog 

2018-08-29 1.2: Added Initial Info section with macOS 
Meta Keys, Unzipping, Show Extensions, Main Project 
Folder, & Your Username; better instructions for 
copying html.json & settings.json; added icon for 
Extensions button in First Extensions; added note that 
Git is for advanced classes; much better instructions for 
installing color & file icon themes; better instructions 
for File Templates



Changelog 

2018-08-20 1.1: Updated Portable VSCode; added text 
re: commas in JSON 

2018-06-22 1.0: First release 
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